Document Storage Systems (DSS) is a privately held corporation and has been the premier provider of health information and document imaging distribution and storage systems to Veteran Affairs facilities for over six years. DSS is located at 12575 U.S. Highway One, Suite 200, Juno Beach, FL 33408.

World Wide Web: www.dssinc.com

DSS DRM Plus program is a trademark of Document Storage Systems, Inc. Outlook, Internet Explorer and Windows are registered trademarks of Microsoft Corporation. VistA is a trademark of the Department of Veterans Affairs, Software Services, and Computerized Patient Record System.

No portion of this manual or software may be reproduced without the prior written consent of Document Storage Systems, Inc.
# Table of Contents

Table of Figures.................................................................................................................................5

DRM Plus – User/Admin Setup Requirements.........................................................................................8
  User Setup........................................................................................................................................8
  Administrator Setup.........................................................................................................................8

Dental Activity System & Dental Encounter System Changes.................................................................9

Transmission & Correction of Processed DES Data................................................................................10

How to Delete Dental Encounter(s)......................................................................................................12

Correcting Errors/Editing in VistA Files..................................................................................................14

Designating Dental Providers................................................................................................................15

Dental Record Manager Fee Basis.........................................................................................................19

Editing CPT/DCode Field Values.........................................................................................................20

Adding Medical Code to the Master ADA Table..................................................................................23

Edit Procedure Costs Option..............................................................................................................27

Administrative Toolbox Functions .........................................................................................................28
  General tab.....................................................................................................................................29
  Print tab.........................................................................................................................................34
  Progress Notes tab..........................................................................................................................35
  Ancillary tab...................................................................................................................................41
  Alerts tab........................................................................................................................................44

Changing Provider/User Permissions (Administrative Toolbox)............................................................45
  Overview.......................................................................................................................................45

Adding/Editing Dental Providers..........................................................................................................49

DES/DAS Reports..................................................................................................................................51
  Provider Summary...........................................................................................................................53
  Understanding CTV and Total CTV columns:....................................................................................54
  Clinic Summary...............................................................................................................................55
  Encounters by Provider..................................................................................................................56
  Encounters by Clinic.......................................................................................................................57
  Non-clinical Time by Provider Report..............................................................................................58
  Fee Basis/Detailed Fee Basis Report...............................................................................................59
  Encounters/Visits by Patient Type Report.......................................................................................60
  Patient Centric Report....................................................................................................................61
  Provider Planning Report................................................................................................................62
  Planned Items List Report...............................................................................................................64
  Active Patients by Provider Report..................................................................................................65
  Unfiled Data by Provider Report......................................................................................................66
  Service Reports................................................................................................................................67

Extract History File Data to a Text File.................................................................................................69

New Extract History File Data to A Text File........................................................................................71
  Considerations/Additional Information..........................................................................................74
  Extract Process Flow.......................................................................................................................75
Developing Excel Reports ........................................................................................................................................76
Importing the DRM/DRM Plus Extract txt File into Access Report.................................................................79
Importing the DRM/DRM Plus Extract txt File into Access Database .............................................................91
Appendix A – Creating Custom Reports Using Excel.........................................................................................97
Appendix B – Business Use of the DRM Plus Software ..................................................................................105
  Local policy and practice................................................................................................................................105
  National policy and practice-Coding Guidelines..........................................................................................105
  National Business Practices – Fee Basis........................................................................................................106
Appendix C – Installing DRM Plus Version Notes/Contact IRM.................................................................107
Appendix D – How to Map Dental CNTs........................................................................................................108
Table of Figures

Figure 1: Transaction with Invalid RVU Value.......................... ..........................................................10
Figure 2: Transaction with a Required Field Missing ..........................................................11
Figure 3: Correcting Errors in VistA Files ..................................................................................12
Figure 4: Delete Dental History Encounter/Visit .........................................................................13
Figure 5: Designating Dental Providers ..................................................................................15
Figure 6: Select Dental Provider Names ..................................................................................16
Figure 7: Designated Dental Provider Displayed ........................................................................16
Figure 8: Prompt for Distributed Provider (for residents filing w/o a cosigner) .........................17
Figure 9: Filing error - data NOT filed to DES/PCE or Dental ..................................................17
Figure 10: PCE Encounter information on VistA .................................................................18
Figure 11: Warning when using different provider than original in Progress Note .......................18
Figure 12: DRM Manager Fee Basis ..................................................................................19
Figure 13: Edit CPT/DCode Field Values ..................................................................................20
Figure 14: Find CPT Code or Description Text ........................................................................20
Figure 15: Enter DCODE.............................................................................................................21
Figure 16: Select Diagnosis Codes ..........................................................................................21
Figure 17: Nationally mapped CPT code ...............................................................................23
Figure 18: Nationally mapped CPT code ...............................................................................23
Figure 19: Adding Local Medical Code to the Master ADA Table ............................................23
Figure 20: Add Codes to the ADA Mapping Table Screen ..........................................................24
Figure 21: CPT Code Search....................................................................................................24
Figure 22: Select CPT Code ....................................................................................................25
Figure 23: Diagnosis Code Search ..........................................................................................25
Figure 24: Edit Procedure Costs Option .................................................................................27
Figure 25: Enter Procedure Costs ..........................................................................................27
Figure 26: Administrative Toolbox menu option .....................................................................28
Figure 27: Administrative Toolbox .........................................................................................28
Figure 28: Date Range Defaults ..............................................................................................29
Figure 29: Other Parameters ....................................................................................................30
Figure 30: Other Parameters Initial tab when opening DRM Plus .................................................31
Figure 31: Set File Folder Button .............................................................................................32
Figure 32: Set Extract Folder .....................................................................................................33
Figure 33: Page Setup ...............................................................................................................34
Figure 34: Progress Note Data Options .....................................................................................35
Figure 35: Note Objects Sequence ............................................................................................36
Figure 36: New Code Boilerplate ..............................................................................................37
Figure 37: New Boilerplate Name ...............................................................................................37
Figure 38: Code Boilerplate Text – Prophy ...............................................................................38
Figure 39: Find CPT Code ........................................................................................................38
Figure 40: Find CPT Code, Enter ADA Code ........................................................................38
Figure 41: Code Boilerplate Text – PROPHY with ADA Code ...................................................39
Figure 42: Code Boilerplate Text – PROPHY with text ...............................................................39
Figure 43: Code Boilerplate ......................................................................................................40
Figure 44: Enable iMedConsent or VistA Imaging .....................................................................41
Figure 45: Launch Imaging from within DRM Plus ....................................................................42
Figure 46: Ancillary Help screen ...............................................................................................43
Figure 47: Allowable Parameters ...............................................................................................43
Figure 48: Select Alert Tabs .......................................................................................................44
Figure 49: Changing Provide/User Permissions .........................................................................45
Figure 50: Grant DRM Plus User Administrative Permissions ..................................................46
Figure 51: Select User .................................................................................................................46
Figure 52: Security Settings ........................................................................................................47
DRM Plus – User/Admin Setup Requirements

User Setup

The following are the requirements for a DRM Plus User:

1. The user must be defined in the “Dental Provider” file (file 220.5).

2. The user must have a Dental Person Class and Provider Type in the VistA Provider file.

3. The user must have the secondary menu option DENTV DRM DSS GUI assigned in VistA.

*Note: DRM Plus providers filing data must have an eight (8) digit provider number in the “Dental Provider” file (see item # 1).

Administrator Setup

The following are the requirements for a DRM Plus Administrator:

1. All of the above setup procedures must be included.

2. *Administrative users (including those with the authority to edit transactions):

   • DENTV XPAR EDIT PARAMS/DENTV DRM ADMINISTRATOR – must be turned to “Yes”.

*Note: Each site must have at least one administrator.
Fiscal Year 2005

The changes detailed in this section occurred in October 2004. Information was distributed via e-mail, conference call(s), web postings, and written communications. After the final transmission of DAS data for FY 04, the Dental Activity System (DAS) capabilities to file data to the local VistA system and to release data to Austin was automatically turned off at the end of October as a result of the installation of DRM Patch 40. For FY 05, no DAS data will be filed to the local VistA or released to Austin.

The installation of DRM Patch 40 also “turned on” the automated transmission of DES data to Austin and “turned off” DAS field limit restrictions. All DES data stored in local VistA files since the installation of DRM Patch 40 has been and continues to be automatically being sent to Austin.

DAS reporting via the VistA DAS package remains available through the current VistA menus, but will only contain data filed for years prior to FY 05. The DES reporting through DRM instituted with the installation of Patch 38 will continue to be available through DRM and DRM Plus. Help for Dental Activity System issues is available from Ms. Jill Palma at the Miami Dental Development Center via 305-324-4455, ext. 4689, or via VA Outlook (Jill.Palma@med.va.gov).

DES help is available through the DRM Plus manual that electronically accompanies each patch release. DES and DRM Plus are also supported in the same manner as other nationally supported VA software products. Problems should be reported to the local site ADPAC and/or IRM helpdesk, who in turn will utilize the VHA National On-Line Information Sharing (NOIS) system (replaced by Remedy during 2005) to log and track any issue(s). Documenting a DES or DRM problem through VHA Remedy system provides a means to catalog problems and to disseminate solutions to those involved in supporting DES, DRM, and other components of the VA computer systems. Document Storage Systems, Inc. (DSS Inc.) also maintains a phone help desk available from 8:00 am to 7:00 pm Eastern time via 561-227-0217.

VA Decision Support System (VA DSS) dental reporting will change in FY 2005 to reflect the new capabilities available through DES. Information will be distributed later concerning these VA DSS dental reporting changes.
Transmission & Correction of Processed DES Data

Sending DES data to the Austin Automation Center (AAC) is a weekly process. The AAC receives this transmission of DES records in the form of standard HL7 messages from the site through the VistA Interface Engine.

Errors are not expected to occur during this transmission process. However, if the data gets corrupted, the software will warn the users when it cannot send data. Also, the software will inform the users when the data sent were not received accurately.

There are two types of errors that may occur during this process.
- The first type is generated by the dental application on VistA when the DES data is being validated before being sent to the AAC.
- The second type is generated by the AAC when they try to validate the data within the HL7 message. Both types of rejections are expected to be rare, especially rejections from the AAC.

The dental application on VistA will attempt to verify DES data before sending it to the AAC via the HL7 messaging process. A new mail group has been added called DENTV HL7 MESSAGES. When missing or invalid data is found, a Mailman message will be generated and sent to members of the DENTV HL7 MESSAGES mail group. Members of the mail group should include a dental administrator and someone from IRM in order to research the reason for the error.

The following is an example of a transaction with an invalid RVU value:

```
Subj: Dental Transaction Error  [#844] 10/18/04@13:16  2 lines
From: POSTMASTER (Sender: CLARK,KAREN)  In 'IN' basket. Page 1 *New*
-----------------------------------------------------------------------
An error was reported for a dental transaction HL7 message.
Invalid data for PATIENT,TEST transaction 42220, file TREATMENT PLAN
TRANSACTION/EXAM field RVU.

Enter message action (in IN basket): Delete//
```

Figure 1: Transaction with Invalid RVU Value

IRM may be asked to use FileMan to view the record 42220 in file Treatment Plan Transaction/Exam (file 228.2) to see what the field RVU contains. The RVU should be a numeric value from 0-9999 (based on the data dictionary definition).

To "repair" this data, the dental administrator should delete this transaction from the patient's transaction list and re-enter it with the correct information. In order to find the correct transaction to delete, the administrator may need additional information from the transaction, such as date entered, ADA code, etc., which can be retrieved via the FileMan Inquire option. If the site is not running DRM Plus (patch 39, where individual transactions may be deleted), then the entire encounter should be deleted via the Dental History tab and re-entered with the correct data.
Once again, receiving these messages and having to "repair" this data will be on very RARE occasions. These messages were designed to ensure that all workload data is being transmitted to the AAC and to let everyone know when this did not occur.

HL7 messages that are sent to the AAC may also be rejected because of missing or invalid data. Once again, this scenario is also very rare due to system checks previously performed on the VistA side. They were performed on the AAC side as a safety measure in case there was a problem with the transmission batch or the transmission process itself.

Due to the nature of the HL7 message along with the rejection that is received from the AAC, this type of message is more difficult to decipher. In order to successfully decipher HL7 messages, some knowledge of HL7 segments and fields will be required. If any questions arise about this type of message, then a Remedy entry should be submitted to have the Dental Record Manager technical support and/or dental development help with the investigation of the error.

The following is an example of a transaction with a required field missing:

![Figure 2: Transaction with a Required Field Missing](image)

The HL7 message ID is contained in the dental DES/HL7 TRANSMISSION (#228.25) file. This ID can be used to look up the HL7 transmission entry. At that point, it can be used to find the transaction ID for either the Dental Encounter (file 228.2) or Dental Fee Basis (file 228.5) whose message was rejected.

In addition to adding members to the VistA mail group, you will also have to create an Exchange Group (A Distribution Group) on your exchange server (should have been created when Patch 40 was initially installed) so that it appears in the Outlook GAL (Global Address List) as follows: VHAYourSite VIE Messages.

**Example:** VHABHHCS VIE MESSAGES (for Black Hills Health Care)

The purpose of this group is to provide the VistA Interface Engine (VIE) Team with an address to send error messages (i.e. “Unable to connect to VistA [your HL7 send node is down], etc.”]. Since all HL7 messaging will eventually be directed through your VIE it is important that this group include persons at your site that are knowledgeable and familiar with the HL7 functionality.

The SEGment, SEQuence, FieLD and Error Code values are used to show which piece of data was missing or invalid.

"Repairing" the data is the same once the transaction has been found (and the offending piece of data was discovered) would follow the same procedure as the errors received on the VistA side.
How to Delete Dental Encounter(s)

An erroneous dental history entry may be deleted directly from DRM Plus. Only administrators can delete dental history encounter data.

To initiate this process:

1. Click the Dental History tab on the Chart/Treatment tab. The following screen is displayed:

![Figure 3: Correcting Errors in VistA Files](image)

2. A right click in the history text window displays the option box Delete History File Encounter/Visit.

3. Clicking the Delete History File Encounter/Visit displays the following box. It displays all the visits that may be deleted.
4. Highlight the visit/encounter to be deleted. All teeth and procedures created by DRM Plus entries for the Visit Date/Time will be deleted when the Delete button is clicked. The visit will be deleted without any additional prompt.

5. Click on OK to return to the Dental History screen.

**Note:** Deleting information from Dental History removes the entire encounter. Once an encounter is deleted, it cannot be recovered. The entire is required to be deleted from VistA as well.

When you are using DRM Plus, another deletion option is available for administrators of the application. Completed Care transactions can be deleted in DRM Plus by highlighting a desired transaction and selecting the Delete key. Deleted transactions will be permanently removed from the encounter without deleting the encounter if at least one completed un-deleted transaction remains associated with the encounter.

**Note:** When DRM Plus is used, you must file (click the “Finish” button) the deleted transactions for the deletions to disappear from the patient chart/graph and transaction table. In DRM Plus, line-item deletions are allowed through the transaction table in the Completed Care screen. Deleting line item entries only affects DRM Plus. The line item entries are required to be deleted from VistA as well. Deleting from VistA is addressed in the section “Correcting Errors/Editing in VistA Files”.

**Note:** If you want to delete all entries from an encounter, never use the line item deletion in Completed Care. Instead, delete the entire encounter in the Dental History tab.
Correcting Errors/Editing in VistA Files

Errors discovered after completing the Progress Note in DRM Plus and filing it in CPRS must be corrected in the VistA files that were populated by the DRM data. VistA procedures must be used to correct these files and the Progress Note.

When an encounter has been completed in DRM Plus, various components are saved in other areas in VistA. These components also have to be corrected or deleted after you have deleted the entire encounter in the Dental History tab in DRM Plus or after you have deleted line item entries in Completed Care.

**DES** – A DES entry occurred when you completed data using DRM Plus. If the entry is edited or deleted in DRM Plus, the associated DES entry must be edited or removed from the Fileman 228.1 file.

**PCE** – The Option/Name to edit or remove the PCE entry would be PCE in VistA, then choose the number 2, PCE Clinician Menu, then select ENC.

**CPRS** – If a Progress Note was completed and signed in DRM Plus, the CPRS note may be appended or hidden. Your IRM support will follow local guidelines as to whether they will actually append or hide the associated CPRS Note.

**Note:** Your IRM staff will assist you in filing these entries.
Designating Dental Providers

To assign a primary and/or secondary dental provider for a patient requires the permission of the DRM administrator. Double-click in the provider area as illustrated in the red box below.

Figure 5: Designating Dental Providers

The Designated Dental Provider screen will appear.
Highlight the provider name and click on the arrows to move the provider name into and out of the Primary Dental Provider field or Secondary Dental Provider field.

Once the dental provider fields contain the selected names, click on the OK button.

Figure 6: Select Dental Provider Names

The provider name(s) will appear at the top of the Patient Chart as illustrated below:

Figure 7: Designated Dental Provider Displayed

Note: Designating primary and/or secondary provider(s) is optional.
Capturing the Distributed (Attending) Provider for residents

This is a new VA Directive. Residents are those users with a Person Class of V030300, or V11550 or V115600. Since most sites require residents to enter a cosigner for the note, the cosigner will default as the distributed provider. If there is no cosigner (e.g., there's no note when using “File Data Without a Note” or the resident is not required to have a cosigner), then the resident - or the user filing data to a resident, must enter the distributed provider before filing.

Figure 8: Prompt for Distributed Provider (for residents filing w/o a cosigner)

If the user tries to file completed data to a resident (that has no cosigning restrictions in VistA) without a distributed provider, the following error will be returned:

Figure 9: Filing error - data NOT filed to DES/PCE or Dental
When the visit is filed to PCE, the resident will become the secondary provider and the distributed provider will become the primary provider for the visit. All procedures and diagnoses will be assigned to the resident.

If an addendum is filed by a resident to the same visit and the distributed provider is not the same as the current PCE Primary provider (the original distributed provider), then the new distributed Provider will be added as a secondary provider.
The process for fee basis reporting changed as follows for Fee Basis cases authorized for payment after **October 1, 2004.**

- When a VA dentist signs a Fee Authorization Form (10-2570d) for payment (or the equivalent authority is invoked), the fee case information must be entered into Dental Record Manager (DRM) by the authorizer or a designee.

- The patient must be registered in CPRS.

- The user will start CPRS, look up the patient for Fee Basis filing, and then launch DRM Plus from CPRS under the “Tools” menu.

- From the DRM “File” menu, the user will select “File Fee Basis” and the graphical user interface (GUI) screen shown below will appear for the user to complete.**

- Once data entry is completed, the user will click “Finish” and the data will be filed to the Dental Encounter System (DES).

![Image of DRM Manager Fee Basis interface](image)

**Figure 12: DRM Manager Fee Basis**

To only enter Fee Basis data inside DRM Plus, a user:

1. Does **NOT** need to be in the Dental Provider file.
2. Does **NOT** need a Person Class in VistA.
3. Does need access to CPRS.
4. Does need access to DRM Plus (DENTV DSS DRM GUI secondary menu option).
5. Does **NOT** need admin access.

**Note:** DRM Plus administrators can run all Fee Basis reports.

**Note:** Patient care provided by fee should be entered in DRM Plus as Diagnostic Findings.
A default primary or default secondary diagnosis for an existing CPT code may be added or changed by the administrator. The fields that may be edited for a CPT code are VA Cost, Private Cost, Selected Diagnosis Codes and Admin Notes.

To edit or add a diagnosis:

1. Click the Treatment & Exam drop-down menu.

2. Choose the Edit CPT/DCode Field Values option.

The following box will be displayed.

To edit or add a diagnosis:

1. Click the Treatment & Exam drop-down menu.

2. Choose the Edit CPT/DCode Field Values option.

The following box will be displayed.
3. Enter CPT Code in the Find box, for instance D6057, and press the Enter key. The following box will be displayed.

![Figure 15: Enter DCode](image)

4. Highlight the desired CPT code and click OK. The following screen will be displayed.

![Figure 16: Select Diagnosis Codes](image)
5. The Change Code Information in the ADA Master Database File screen appears as illustrated above. Up to five diagnostic codes may be assigned to a CPT code. The first code in the list is the primary diagnosis default.

6. Enter search criteria in the Diagnosis Code Search box and hit enter.

7. Highlight the desired diagnostic code and click the > button to move it to the Selected Diagnosis Codes box. Continue this process as required.

8. Click the < button to delete highlighted codes as required. The ^ button moves a highlighted code up in the list of diagnoses.

9. After all selections have been made, click OK to complete the process.

10. Enter the VA Cost to Perform and Equivalent Private Cost fields in dollars and cents. This information is not mandatory; however, if entered, it is available in reports.

11. **Administrators can enter text freely in the Admin Note field to compliment coding guidelines.**

**Note:** If the Procedure Code is considered a national code, the text box will appear pre-populated with a RVU Value, VA-DSS Product Line and Diagnosis Code.
Adding Medical Code to the Master ADA Table

These codes may be added to the ADA table. Each CPT code must have at least one designated diagnosis code attached to it. Once a default diagnosis has been designated it may be changed. The person assigned this task must be an administrator. These changes apply to the VISTA system for the specific facility.

Adding Medical Code menu will not allow the administrator to add a nationally mapped CPT code that’s already in the ADA Mapping table and assign it new RVU and Product Line values. If the user tries to add a CPT code already in the table, a warning message will display:

Figure 17: Nationally mapped CPT code

CPT (ADA) code added entries will not be allowed using this menu. The CPT codes maybe edited using the Edit CPT/DCode Field Values menu. If the user tries to add a CPT code, a warning message will display:

Figure 18: Nationally mapped CPT code

To add a Local Medical Code:

1. Click the Treatment & Exam menu.

Figure 19: Adding Local Medical Code to the Master ADA Table
2. Click the Add Medical code to Master ADA Table option. The following box will be displayed:

![Add Code](image1)

**Figure 20: Add Codes to the ADA Mapping Table Screen**

3. Enter selection criteria in the CPT Code Search box, for instance 990, and press Enter. The following screen will be displayed as illustrated:

![Add Code](image2)

**Figure 21: CPT Code Search**
4. Highlight the desired code and click the > to move it to the selected CPT code box. The window will appear as displayed below.

Figure 22: Select CPT Code

5. Each CPT code must have at least one default diagnosis.

6. Enter search criteria in the Diagnosis Code Search, for instance V54, and press Enter. The following screen will be displayed:

Figure 23: Diagnosis Code Search
7. Enter the RVU Value in the text box. Using the pull-down arrow, choose the appropriate VA-DSS Product Line option. If the RVU Value is considered a national code, the text box will appear pre-populated.

Detailed diagnosis coding process as follows:

1. Up to five diagnostic codes may be entered per CPT code. The first diagnostic code is the default.

2. Highlight the desired diagnostic code and click the > button to move it to the Selected Diagnosis Codes box. Continue this process as required.

3. Click the < button to delete highlighted codes as required. The ^ button moves a highlighted code up in the list of diagnoses.

4. After all selections have been made, click OK to complete the process.

To cancel everything including selection of CPT and diagnosis codes, click the Cancel button.
The Edit Procedure Costs Option is available from the Treatment & Exam drop down menu and allows the user to change the Procedure Codes within the DRM application.

![Image of Edit Procedure Costs Option]

**Figure 24: Edit Procedure Costs Option**

To enter costs into this table, place the cursor in the desired field and type the cost in dollars and cents.

Once the cost is entered, press the Enter key. This will result in the ADA/CPT cost data to immediately file and the cursor will automatically move to the next field in the table.

**Note:** When using the Edit Procedure Costs option, if the user edits an existing cost, make sure you press Enter or click to a different box so that the new cost is established.
The Administrative Toolbox is accessed from the Tools drop-down menu. Only users with DRM Plus administrator permissions are permitted use these features. These features are the same in User Options except the Treatment System tab is not included. The following screen is displayed:

![Administrative Toolbox menu option](Figure 26)

Clicking the Administrative Toolbox option displays the DRM Plus Administrative Settings dialogue box displayed on the following screen:

![Administrative Toolbox](Figure 27)
**General tab** – Setting most parameters on the General tab from the Administrative Toolbox will supersede all user settings. The parameter settings will all be the same until a user resets the parameters in their User Options.

The Date Range Defaults button allows the administrator to customize the number of days DRM Plus looks back for numerous options such as Visits/Admissions, Progress Notes, Lab Results, and Tooth History. The following screen is displayed:

![Date Range Defaults](image.png)

**Figure 28: Date Range Defaults**

Set the new values by clicking in the appropriate boxes and typing the desired values or by using the arrows. Click OK to complete the process.

**Note:** The Date Range defaults should not be changed unless you check with local IRM support. Increasing these values can degrade overall network/systems performance.
The **Other Parameters** button allows the administrator to set the screen tab settings order of preference. The following screen is displayed:

![Figure 29: Other Parameters](image)

Use the pull-down arrow to select the desired initial tab to be displayed when DRM Plus is opened. Towards the bottom of the Other Parameters screen is a checkbox option that allows boilerplate inserts to be prompted or not. These boilerplates are residing in CPRS and usually tied to a Progress Note title.
The user will have a choice to select “Initial tab when DRM starts” using the pull-down menu shown in the following screen.

![Figure 30: Other Parameters Initial tab when opening DRM Plus](image)

At the bottom the dental administrator can control whether or not PCE Visits may be created "on the fly" within DRM Plus. If the site wants to disallow PCE Visit creation, then only existing visits may be selected.
The **Set File Folder** button allows the administrator to set the directory/file location where the text files are located for importing into a patient progress note. The following screen is displayed:

![Set File Folder Button](image)

**Figure 31: Set File Folder Button**

Highlight the area or folder that will be used to import the text files. Click OK to complete the process.
The **Set Extract Folder** button allows the administrator or users with permission of Extract History Reports to set the directory/file location where the extraction of the Dental History file will be stored. The following screen is displayed:

![Set Extract Folder](image)

**Figure 32: Set Extract Folder**

**Note:** Set Extract Folder is only present if the user is allowed to do History Extracts or is a DRM Plus Administrator.
Print tab – Clicking on the Printing tab and then on the Page Setup button displays the following screen:

![Page Setup Window](image)

**Figure 33: Page Setup**

The Page Setup window may be used to format the following:

- Margins for the Progress Notes printed.
- Type of fonts preferred.
- Page setup to be used – portrait or landscape.
- Page number counter.

Use the drop-down arrows, radio buttons and browse buttons to make the desired settings. Click OK to complete the process and save the settings.
**Progress Notes tab** – Clicking on the **Progress Note** tab and then on the Progress Note Data button allows the administrator to modify the default settings for Note objects. The following screen is displayed:

![Progress Note Data Options](image)

**Figure 34: Progress Note Data Options**

The Progress Note data selections have been preset and are shown “grayed out” above. Items that do not appear “grayed out” may be selected in addition to the pre-selected items.

Once objects have been modified, click OK.

**Note:** This Code Boilerplate checkbox activates the importing into the Progress Note of any boilerplate created in DRM Plus.
Clicking on the **Progress Note** tab and then on the Set Note Sequence button displays the following screen:

![Figure 35: Note Objects Sequence](image)

The Note Objects Sequence window may be used to sequence items that will be included in patient Progress Notes. Highlighting items listed in this screen and moving them up/down with the arrow buttons on the right side of the screen determines the sequence. The top item listed will be the first item sequenced in your Progress Note.
Clicking on the **Progress Note** tab and then on the Configure Code Boilerplate button displays the following screen:

![Image](image_url)

**Figure 36: New Code Boilerplate**

The Code Boilerplate function allows users to develop code-specific boilerplates. When the Code Boilerplate checkbox is checked in the progress note data screen, DRM Plus will automatically include these boilerplates in the Progress Note whenever the related CPT code is selected as a Completed Care item.

Clicking the Add New button displays the following dialogue box:

![Image](image_url)

**Figure 37: New Boilerplate Name**
Each boilerplate must be named. In this example, the name chosen is “Prophy”. Entering “Prophy” in the name box and clicking on OK displays the following screen:

![Figure 38: Code Boilerplate Text – Prophy](image)

Clicking the Add Code button displays the following screen:

![Figure 39: Find CPT Code](image)

Type the appropriate code in the Find box and pressing the Enter key displays the following:

![Figure 40: Find CPT Code, Enter ADA Code](image)
Highlighting the desired code and clicking OK displays the following screen:

![Code Boilerplate Text – PROPHY with ADA Code](image1)

*Figure 41: Code Boilerplate Text – PROPHY with ADA Code*

Place the cursor in the right-hand box and typing or cut/paste in the desired boilerplate text. The following screen shows the text added:

![Code Boilerplate Text – PROPHY with text](image2)

*Figure 42: Code Boilerplate Text – PROPHY with text*

Clicking OK displays a confirmation box. Clicking OK on the confirmation box displays the following screen:
Figure 43: Code Boilerplate

Code Boilerplates can be edited or deleted by highlighting the appropriate code and clicking on the Edit or Delete button. Clicking OK completes the Code Boilerplate entry process.

**Note:** Multiple boilerplates may be added for a single CPT code. Multiple CPT codes may be associated to the same boilerplate. As many boilerplates and related codes as desired may be established.
Ancillary tab - To enable iMedConsent, VistA Imaging, MiPACS, etc. on the Tools menu, click in the associated checkbox of the desired application(s). Use the Browse button(s) to set the location and filename of the application(s). The MiPACS doesn’t require a Browse button location and filename.

The administrator may type entries into the table directly, or click the 'Browse to Add Option' button to find (.exe) files on a local or network drive. Website addresses have to be typed in or can be copy/pasted into the table. A limited number of parameters may be appended to an application, which will be converted from their parameter name to a real value before starting the application. IRM can help with parameter passing since this is similar to setting up CPRS Tools options. Click the Set button to enable any of the applications desired.

Figure 44: Enable iMedConsent or VistA Imaging
To launch iMedConsent, MiPACS, or VistA Imaging from within DRM Plus choose the corresponding option from the Tools menu.

![Figure 45: Launch Imaging from within DRM Plus](image)

The dental administrator may customize up to 10 ancillary applications or websites to launch from the DRM Plus Tools menu option. This replaces the "hard-coded" launch for VistA Imaging and iMedConsent and allows additional applications, including Microsoft Excel for example, to be launched depending on the needs of the site.

**Note:** Settings for these options must be configured in the Administrative Toolbox option. The location for these application executables may require IRM assistance.
A special Help button is available to describe the feature and give examples. Clicking the ‘?’ button brings up the following screen:

![Ancillary Help screen](image)

**Figure 46: Ancillary Help screen**

This page contains examples and definitions of allowable parameters that DRM Plus understands and can convert to real values.

For example, the top entry is how the VistA Imaging application setup would be configured. The user could type in, or look up, the exe name and location and then would add the parameters required by VistA Imaging to launch with the current patient from DRM Plus. Those parameters are:

- %DFN (the patient DRM Plus is using)
- %MREF (specific variable for VistA Imaging)
- %SRV (the server DRM Plus is using)
- %PORT (the port DRM Plus is using)

The Allowable Parameters box describes the specific parameters that DRM Plus may pass to another application.

![Allowable Parameters](image)

**Figure 47: Allowable Parameters**
**Alerts tab** – After selecting the Alerts tab, the Common Alerts screen will appear. To add alerts to the list, click the Add button and follow the prompts. To delete an alert from the list, highlight the alert and click the Delete button. Once an alert has been added, all users will be able to select the Common Alerts by clicking on the Alerts icon. If an alert has been deleted, it will no longer exist in the Common Alerts box.

![Figure 48: Select Alert Tabs](image)

Once selections have been made, click the Done button.
Overview

Administrative permissions allow users to perform several functions in DRM Plus. Administrators can change defaults for users which can supersede user options.

Note: When any defaults are changed by an administrator, the user needs to be notified because the user may change it back under User Options in the Tools menu.

Note: Certain settings set by administrators for the entire DRM Plus may be changed by users for their individual profiles. See Using the DRM Plus Menu bar, Tools -User Options

- Setting system defaults for date ranges used for viewing various historical entries.
- Establishing default screen views.
- Establishing default print settings.
- Establishing other provider permissions, correcting mistakes.
- Adding local medical codes to the ADA table.
- Adding/changing default diagnoses to ADA codes and extracting Dental History data to create reports.
- Adding or editing Provider information.
- Extracting Dental History to prepare informational reports
- Extracting DES Reports

The three icons at the top of the DRM Plus Administrative settings are identified in the following screen:

![Administrative Settings](image)

Figure 49: Changing Provider/User Permissions
1. The first icon (identified below) gives a DRM Plus user administrative permissions.

![Administrative Settings](image1)

**Figure 50: Grant DRM Plus User Administrative Permissions**

2. Clicking on this icon displays the following box:

![Select User](image2)

**Figure 51: Select User**

3. Enter the selection criteria in the user search box by typing in the user’s name, highlighting the desired provider and clicking Select User. After selecting the user, the administrator can grant full administrative privileges.

5. Clicking on the Security tab displays the following box:

![Security Settings](image)

**Figure 52: Security Settings**

6. Clicking the “Grant administrator privilege” checkbox grants full permissions.

7. Clicking the “Allow history extract” checkbox grants only this permission to save Extract History Reports to be used in Excel.

8. Clicking the “Allow user to change Primary/Secondary Providers” checkbox grants only this permission.

9. Clicking the “Allow user to edit Dental Eligibility (on the Cover Page)” checkbox grants only this permission.

10. The User TBox Access menu is provided to allow users the option to customize their profiles.
    - The default for all users is “E – Edit”. However, specific institutions may prefer to deny this permission.
    - The “N – No Access Allowed” allows no editing of the user’s profile.
    - The “D – Display Only” setting will allow users to view their profile settings.
The second icon, the yellow key, is used to return the user back to the main administrative settings screen.

![Main Administrative Settings Icon](image1)

**Figure 53: Main Administrative Settings Icon**

The third icon is used to display Broker Calls history. This tool is normally used for problem details and not routinely used by the provider.

![Broker History Icon](image2)

**Figure 54: Broker History Icon**

1. Clicking this icon displays the following screen. The Maximum Calls option is used to determine the number of broker calls displayed at one time.

![Broker History Settings](image3)

**Figure 55: Broker History Settings**

2. The Previous or Next buttons can be used to display the broker call information as needed. The Show All button will generate all of the broker calls on the screen.

**Note:** The Last Broker Call option is used by IRM and providers to document problems.
Adding/Editing Dental Providers

Provider Add/Edit Option

The Provider Add/Edit option is available from the Tools drop down menu and allows the user to add or edit Dental Providers within the DRM application. New Dental Providers are added from entries in the New Person file. Along with editing the existing four-digit Provider ID, a new eight-digit Provider ID is available which uses codes from standardized Provider Types and Provider Specialties tables. Dental Providers may also be inactivated through this option. Inactivated Providers can not be selected for reports.

Figure 56: Adding/Editing Dental Providers Option

1. Clicking the Provider Add/Edit option displays the following set-up screen:

Figure 57: Dental Provider Set Up Screen
2. The Dental Provider Edit screen is explained as follows:

- **Dental Provider** look-up auto-fills with all entries in the Dental Provider file. Select/click on the Dental Provider dropdown arrow and select/highlight the desired provider.

- **Provider Type** displays a list of provider types from the VistA file and includes a two-digit code used to build the new eight-digit Dental Provider ID required for DES filing. Select/click on the Provider Type dropdown arrow and select/highlight the appropriate provider type.

- **Provider Specialty** displays a list of provider specialties from the VistA file and includes a two-digit code used to build the new Dental Provider ID. Select/click on the Provider Specialty dropdown arrow and select/highlight the appropriate provider specialty.

- **Provider Seq#** is the next available four-digit sequenced number to “build” the new 8 character Dental Provider ID. This number can be edited if desired; however, editing is not required.

- **Dental Provider Number** displays the “new” eight-digit provider ID. This is a “read only” field.

- **Inactive** flag and Old Provider ID are still needed for DAS.

- **Old Provider ID** may be filled with “old” four-digit ID from the previous provider number used in DRM. This field is not required to be filled out in DRM Plus.

3. Select/click the “OK” button to file the “New” Dental Provider Number into VistA.

**Note:** All dental providers must have an 8 digit provider number to receive workload credit.
DES/DAS Reports

DES/DAS Report Selection screen: The Report Selection screen has changed to add reports. The Report Selection screen contains three tabs, one for the original general reports, one for patient-centric reports and one for planning reports.

Figure 58: Tools Menu for DES/DAS Reports

Clicking on the Tools menu and clicking on Reports displays the following screen:

Figure 59: DES/DAS Reports General Tab

Types of Reports:
- **Provider Summary** – summary counts of procedures by Station/Provider and Dental Classification.
- **Clinic Summary** – summary counts of procedures by Station and Dental Classification.
- **Encounters by Provider** – detailed listing of procedures by Station/Provider.
- **Encounters by Clinic** – detailed listing of procedures by Station.
• **Non Clinical Time by Provider** – total days by Provider for time applied to Education, Admin, Research, and Fee.

• **Fee Basis/Detailed Fee Basis** – total amount authorized and number of cases by Dental Classification.

• **Encounters/Visits by Pat Type** – summary counts of encounters/visits by patient type.

Use the radio buttons to select the desired report. Use the checkboxes to create variations of the reports.

Checkboxes include the following:

- **All Providers?** – This selection shows the report for all providers using the provider ID numbers.
- **Use Provider Name on Reports** – This selection shows the report using provider names.
- **Complete** – This selection includes completed care in the report.
- **Planned** – This selection includes planned procedures in the report.
- **Deleted** – This selection includes deleted completed care procedures in the report.

Using the radio buttons in the Patient Status box includes or excludes the selection in the report.

Clinic Summary, Sittings by Clinic and Fee Basis reports do not offer Provider selection.

Provider Summary, Sittings by Provider and Non Clinical Time by Provider allow Provider selection. De-selecting the All Providers checkbox displays a list of providers to choose from. One or more provider is selectable within the list for Provider Summary and Sittings by Provider.

Start Date/End Date selections display a calendar on the drop down. The dates default to the current date. Future dates are not allowed in the Start Date/End Date fields.

The Station defaults to the users default station. This can be changed by selecting a different optioned station. Transaction Status – Allows selection of completed care, planned procedures, and/or deleted transactions. Patient Status – Allows selection of active, inactive, or both.

A new checkbox allows the user to display/print the provider name vs. the provider id on the provider reports.
Provider Summary

The Provider Summary report replaces the DENTTREATPROV RPT in VistA. The optional 3rd page prompted in the VistA report displays as total values at the end of the columns. The $Value prompt in VistA is not supported in the DRM report. Dates included in this report come from the Date Created field for the DRM history file entry, not the Visit date.

Figure 60: Provider Summary

When creating a “Provider Summary” report, the user may select one or more providers (using Shift/CTRL keys) or all providers by using the “Dental Provider No.” drop-down menu. The user may also select to either show all rows/columns or to show just those rows/columns that contain data. The report information may be saved to an Excel spreadsheet by choosing the “Save All to XLS” or “Save to XLS” button. The user may also print the selected information displayed for an individual provider or the user may select “Print All” to print for all providers.
Understanding CTV and Total CTV columns:

This Provider Summary report has the Report Category Type radio button set to the “30 DAS” option. This will result with CTV values instead of RVU values.

Figure 61: Understanding CTV and Total CTV columns

Diagnostic Films – EXT and INT (extraoral/intraoral) always have 0 CTV units and CTV totals. These totals are found in the Patient Receiving X-rays row. All other CTV Units are grabbed from the Dental Type of Service file in VistA.

In VistA, the Tot CTV column is calculated (# Completed * CTV = Tot CTV); in DRM the Tot CTV column is simply the transaction CTV column added for each category.

The Extractions (Weighted) row, the Tot CTV column is calculated in this way: \( A = \text{Total CTVs for class}, \quad B = \text{simple extraction count for class (i.e., 1 per extraction), and CTV Units (always 4)}; \quad (\text{CTV unit} \times B) + (A – B) = \text{value. The value for each Class is added together for Tot CTV.} \)

For example, Class 1 above has ‘1’ “Extractions (weighted); to calculate the Total CTVs; \( (4 \times 1) + (1 – 1), \) or \( (4) + (0) = 4 \)

Note: To see how many extractions you have (hidden value), see the Provider Summary report using the “ADA/CPT” radio button.
Clinic Summary

Replaces the Clinic Summary report DENTTREATCLINIC RPT in VistA. This report is basically the same as the Provider Summary except that the entire station is displayed (all providers).

Figure 62: Clinic Summary
Encounters by Provider

The “Encounters by Provider” report replaces the DENTTREATSITPROV RPT in VistA. Each transaction is displayed, making this a potentially huge report. Dates included in this report come from the Date Created field for the DRM history file entry, not the Visit date. Data is displayed chronologically.

![Figure 63: Encounters by Providers](image)

When creating a “Encounters by Providers” report, the user may select one or more providers (using the Shift/CTRL keys) by using the “Dental Provider No.” drop-down menu. Again, the user may select “Save All to XLS” or “Save to XLS” to save the current data to an Excel spreadsheet. The print options are the same as in the “Clinic Summary” report.

Total sittings are equal to the number of History File entries for the selected date range. If the report is large and the number of rows in the display is greater than (> 65,000, the system will not allow a save to Excel. A message will appear that the user needs to modify the date range.
Encounters by Clinic

The “Encounters by Clinic” report replaces the DENTTREATSIT RPT in VistA. This report is basically the same as the Sittings by Provider report except that the entire station is displayed (all providers).

![Figure 64: Encounters by Clinic](image)

This report may be very large and take a good amount of time to process.
Non-clinical Time by Provider Report

The “Non Clinical Time by Provider” report replaces DENTNCLINTIME PROV in VistA. The data on the new report and the VistA report should always match and may be verified by checking in VistA.

Figure 65: Non-clinical Time by Provider Report
Fee Basis/Detailed Fee Basis Report

The “Fee Basis/Detailed Fee Basis” (type 5) report replaces the Applications and Dental Fee (type 5) report DENTFEE RPT in VistA. These two reports will never have the same data since they are from two different options (one in VistA, a new one in DRM) and two different VistA files.

The new Fee Basis report displays data from the new DRM File Fee Basis option available on the File menu.

![Fee Basis/Detailed Fee Basis Report](image)

Figure 66: Fee Basis/Detailed Fee Basis Report
**Encounters/Visits by Patient Type Report**

The “Encounters/Visits by Patient Type” report has been created to display data from DRM Plus in an easily readable format of providers and patients by inpatient and outpatient categories.

![Encounters/Visits by Patient Type Report](image)

**Figure 67: Encounters/Visits by Patient Type Report**
Patient Centric Report

The patient centric report screen allows the user to lookup patients other than the one in the current session. The patient is only used for report generation - changing patients in DRM Plus is still not allowed. Clicking on the Patient tab displays the following screen.

![Patient Centric Report tab](image)

**Figure 68: Patient Centric Report tab**

The **Patient Visit List** report allows the user to look up any patient and view a list of visits, including visits in the old Dental Activity System (DAS). The current patient will default for the user and the date range will default to include a year's worth of data. Visits are shown in reverse chronological order.

![Patient Visit List Report](image)

**Figure 69: Patient Visit List Report**
**Provider Planning Report**

The following reports are available on the Planning tab:

- **Provider Planning** – summary of treatment planned items by provider.
- **Planned Items List** – sortable list format of provider planning.
- **Active Patients by Provider** – displays a list of patients with ‘Active’ dental encounters.
- **Unfiled Data by Provider** – displays a list of patients who have “unfiled” data for providers.

Clicking on the Planning by Provider tab displays the following screen.

![Planning Reports tab](image)

**Figure 70: Planning Reports tab**
The **Provider Planning** report contains the Provider number, Patient name and last four digits of the Social Security number, the Planned Procedures and dates of appointments.

![Planning Provider report](image.png)

Figure 71: Planning Provider report

The checkboxes for the type of provider include:

- **Use Primary Provider** – Refer to “Designating Dental Providers” section of this manual.
- **Use Secondary Provider** – Refer to “Designating Dental Providers” section of this manual.
- **Use Entered by Provider** – This would be used if the patient has not been assigned a Primary/Secondary Provider.
**Planned Items List Report**

The **Planned Items List** report contains all of the same information as the existing Provider Planning report, but in a sortable list format. Users may click on the headings to resort and subtotal by column.

![Planned Item List Report](image)

*Figure 72: Planned Item List*
Active Patients by Provider Report

The **Active Patients by Provider** report displays a list of patients with 'Active' dental encounters for providers.

Note: this report may display many more patients than the provider truly has with an active status due to the default filing flag in DRM Plus - the default is Active and most users do not change this. There are two things in DRM Plus to address this issue:

- The most recent dental encounter may be updated by the user through the new Case Management 'Status' field on the Cover Page.

- Users will be prompted to change the status of the patient if this is a completed encounter when they click the Finish button. The provider will be prompted because the patient will no longer have any planned items however the provider allowed the status of the patient to remain Active.

![Active Patients by Provider Report](image)

**Figure 73: Active Patients by Provider Report**
Unfiled Data by Provider Report

The **Unfiled Data by Provider** report displays a list of patients who have "unfiled" data for providers. Unfiled data is data that resides in a temporary, scratch pad type of area and is only visible by the provider the data has been filed to. This data is not part of the patient record and should be filed to completion in a timely manner.

![Unfiled Data by Provider](image)

**Figure 74: Unfiled Data by Provider**
Service Reports

Service reports are KLF-style reports retrieving data from DAS or DES type categories.

Figure 75: Service Reports under Tools Pull Down Menu

These reports include all codes (medical/dental procedure codes) for local reporting.
A sample service report is illustrated below.

Figure 77: Sample Service Report
Dental History File data may be extracted and saved in text (.txt) format and then converted to an Excel worksheet format. The person assigned this task must have the required permissions.

To initiate this process:

1. Click on Tools in the DRM Plus menu bar. The following screen is displayed:

![Figure 78: Extract History File Data to a Text File](image)

2. Clicking on the Extract History File option displays the following screen:

![Figure 79: Select Extract History File Data](image)
3. The top portion of this box provides the instructions for completing the data extract.

4. In the screen illustrated above the Start Date is designated as August 17, 2006, and the End Date is August 17, 2006. The Folder designation is DRM Dental Extract History. These dates may be changed to suit the user’s preferences by clicking on the down arrows.

Note: The Output file selection requires advance planning. Prior to extracting data, create a folder on the hard-drive or network directory. This folder can then be designated in the Administrative Toolbox option Set Extract Folder discussed earlier in this manual.

5. The data to be extracted must have a filename and must be a text (.txt) file. In the “Add new file directory” box complete the filename designation. Click in the box, add a backslash (\) followed by the name of the file, followed by a dot (.) txt.

Note: The Optional Select Provider checkbox may be used to extract data for only one provider. Click in the checkbox to display a Provider Selection box.

6. Click OK to complete the extract function and save the file to the designated folder.

Note: Do not use this extract function for long reports. Your PC will display an hourglass, and no other applications can be run until the extract report finishes.

Note: If you are planning to run a long report, use the New Extract History File option.
The New Extract History File option available in the Tools menu runs via a TCP/IP server on the user’s workstation, rather than through the VistA RPCBroker on your local PC.

This provides at least two major benefits to the user:

- The user’s workstation is not tied up while the extract is running.
- The RPCBroker will not time out during long extracts.

Additional features have been added to the extract, including the ability to queue it to run at a later date/time and a flag to denote that the .txt files will be used in Excel so that multiple files are automatically generated when the row count reaches 65K rows. The output file contains exactly the same data as the old extract option – there are no changes concerning the content of the .txt files.

**Note:** Users must obtain a valid Port # and IP address from their IRM department to use the new Extract option. The Port # should be 15,000 or greater. If you have any questions, obtain your Port # from IRM.

The Extract History File option is available in the Tools menu for Administrators only. Clicking the option displays the following screen:

![Figure 81: New Extract History](image-url)
1. When using the “New Extract History File” option, the “Start Date” and “End Date” fields are defaulted to the current date. Future dates are not allowed to be entered into these fields.

2. Clicking the Parameters button results in the display of the “Extract System Parameters” screen.

**Note:** Parameters (IP address and Port #) **must** be defined for the extract to work properly. Contact IRM for this information.

![Extract System Parameters](image)

Figure 82: Extract System Parameters

3. When in the “Extract System Parameters” screen, the user must fill out the “IP address,” “Port #,” and “Default Folder.”

4. The IP address is where the application that receives the extract data from VistA resides.

5. The Port # is the port that the application will be listening on. The Port # should be 15,000 or greater.

6. The Default Folder is the location used as a starting point for the extract file.

7. After completing changes to the fields, the user may select “Okay” to save changes and continue with the settings saved or the user may choose “Close” to continue without saving. These parameters are stored as “System Parameters” on VistA.

   a. IP address is stored as DENTV DRM EXTRACT IP
   b. Port # is stored as DENTV DRM EXTRACT PORT
   c. Default Folder is stored as DENTV DRM EXTRACT FOLDER
8. This file must be in “.txt” format. If the “Optional Select Provider” checkbox is selected, a Provider Selection screen will be displayed.

Figure 83: Option Select Provider

9. If the user selects a different provider, only that provider’s history will be in the extraction. The user may also choose to run the extraction at a later date and time by changing the “Run Extract On:” and “At:” fields.

10. If the extract is large, multiple files will be generated. To run the extract, the user must click “OK” or to cancel the extract the user must click the “Cancel” button.
Considerations/Additional Information

Output from the Extract is sent to the file at the file location specified on the Extract edit screen. There
are no changes to the content of the extract and there are no manipulations of data that are part of the
extract (e.g. weighted CTV values are not calculated by the system).

The extract application (DRMEXTSRV.exe) must reside in the same location as the DRM application
(usually …\DOCSTORE). If the message “The specified file was not found” is received after clicking
“OK” on the Extract History File Data screen, then the DRMEXTSRV.exe file was not found.

Clicking the “OK” button starts the DRMEXTSRV application listening on the port # defined on the
parameters screen. A “DRM Extract” icon will appear in the system tray. It can be manually shut down
by right-clicking the icon and selecting Shutdown. If the DRM Extract process is actively talking to
VistA, placing the cursor over the icon will cause the message “Receiving data…” to display.

Clicking “OK” displays the following message. The Task # is the Taskman job number and can be used
by the IRM department to check if the Taskman task completed, or an error occurred.

![Figure 84: "Extract successfully queued" message](image)

If an extract is queued on the VistA side and DRMEXTSRV is not running (it was shutdown), the tasked
job will quit without outputting the .txt file.

**Note:** Since the extract is queued, there is no notification to the user that the IP address or Port # might
be wrong so it is important that the IP address and Port # fields contain correct information.

Only one DRMEXTSRV application may be running on a workstation at a time. Trying to queue
another extract – even for a different date/time will result in the following error. (This means the user
cannot queue one extract for 11 pm and one for 5 am on the same machine.

![Figure 85: "May only queue one extract at a time" message](image)

When the extract is finished sending data to the .txt file, the DRMEXTSRV application will be closed
automatically and another extract can be queued. If multiple files are generated for the extract, then they
are numbered sequentially, e.g. Extract.txt is the user selected name, followed by Extract1.txt,
Extract2.txt. Since the extract is queued and the user does not know if it ran to completion, the last row in
the .txt file is “END OF FILE” to denote that all rows were sent to the workstation TCP/IP process. If there are multiple files, all files except the last will contain the text “END OF FILE (CONT...)” to denote that there is additional extract data in other files.

**Note:** Multiple files are only output if the Excel format is selected on the Extract screen and there are > (greater than) 65K rows of text.

**Extract Process Flow**

- User selects New Extract History option.
- Extract Parameters retrieved from VistA.
- User selects extract criteria e.g., start/end dates, file location, file name, run date/time.
- User clicks OK.
- DRMEXTSRV starts on workstation using Port# from parameters page, icon appears in system tray.
- Taskman job is queued on VistA for the selected Run Date/Time.
- Message appears to user that job was successfully tasked, Extract History Data screen closes.
- At the Run Date/Time Taskman starts the extract job.
- Tasked Job retrieves Dental History data for selected dates and/or provider.
- Tasked Job connects to DRMEXTSRV on the workstation using the IP address and Port #.
- Tasked Job sends File location to DRMEXTSRV.
- DRMEXTSRV opens file (overwrites data if file exists).
- Tasked Job sends Dental History data to DRMEXTSRV.
- DRMEXTSRV writes data to file.
- Tasked Job sends "DONE" message.
- DRMEXTSRV closes file.
- Tasked Job sends "SHUTDOWN" message.
- DRMEXTSRV closes.

Once the Tasked Job is completed and the file has been created, the process for retrieving and creating Excel worksheets is the same as discussed above under the title “Extracting Dental History File Data to a Text File.”
The steps are to open Excel and then open the saved file. To open Excel you would:

1. Click on the Excel Shortcut (if available), otherwise.
2. Click on Start.
3. Click on Programs.
4. Click on Microsoft Office.
5. Click on Microsoft Excel. A blank Excel workbook will open.

To Open the saved file:

1. From the menu bar, select the File menu.
2. Click on the Open option.
3. Navigate to the directory/network where the extract file was saved.
4. Navigate to the saved .txt file and click Open or double click on the file name.

A screen similar to the one displayed will appear.

5. Click the Delimited radio button. Click Next.
A screen similar to the one displayed below will appear.

Figure 87: Delimiters Options

6. Checkbox next to Tab is the default.
7. Click the check box to the left of Other.
8. Type a ^ (shift 6) within the window to the right of Other. Click Next.

A screen similar to the one displayed will appear.

Figure 88: Preview Text

9. Click Next.
10. Click **Finish**. The following figure will display the extracted Excel data.

![Figure 89: Report Preview](image)

11. The text file can now be saved in Excel format (example: FileName.xls). Select File from the menu bar and choose the Save As option. The file should be renamed and saved with the (.xls) suffix.

12. The Excel worksheet can now be modified to create any number of custom reports to meet the user’s specific needs. The Excel tools are very powerful and just about any type of report desired can be created depending upon the user’s Excel skills.

**Examples of Possible Reports:**

- All Procedures by Provider
- All Procedures by Patient
- All procedures by Clinic
- Reports by ADA Code
- Specific ADA Codes by Provider
- CTV’s by Provider
- Reports by Diagnosis

**Note:** See Appendix A – Creating Custom Reports using Excel Functions.
Importing the DRM/DRM Plus Extract txt File into Access Report

After obtaining DRM/DRM Plus information into a txt file through the extract function of the application and saving that information into a pre-set folder, that information can be placed into Microsoft Access for reporting purposes similar to Microsoft Excel.

1. Within the Microsoft Access program, click on the File pull-down menu and choose the Open option.

![Figure 90: Import Extract txt File into Microsoft Access](image)

Figure 90: Import Extract txt File into Microsoft Access
2. The Open window appears. Using the drop-down arrow, search and highlight the area where the pre-set extract folder is located. The pre-set extract folder contains the information previously extracted from DRM/DRM Plus.

Figure 91: Open File
3. Once the area where the folder is located has been identified within the open screen, use the mouse to click and highlight the pre-set folder.

Figure 92: Select File Location
4. Using your mouse, click on the File of type drop-down arrow and choose “All Files (*.*)” as the extension.

Figure 93: Viewing All File Types
5. Using your mouse, click to highlight the .txt file extraction saved in DRM/DRM Plus. To access the file, choose one of the following options:

- Double-click on the .txt file; or:
- With the .txt file highlighted, click on the Open button.

Figure 94: Opening .txt File
6. The following wizard will appear and the radio button preceding “Delimited…” must be selected. Select the Next button to continue the process.

![Link Text Wizard](image)

Figure 95: Link Text Wizard
7. Within the Link Text wizard screen, select the radio button preceding “Other” and in the text area located to the right side, type a ^ (Shift/6). To continue, select the Finish button.

Figure 96: Choose the Delimiter that Separates Your Fields (^)
8. When the “Finished linking table…” pop-up window appears, select the OK button.

![Figure 97: "Finished linking table" confirmation](image_url)
9. Select the Reports option that appears on the remaining screen. Using your mouse, highlight and double-click the “Create report by using wizard” feature.

Figure 98: Create Report by Using Wizard
10. The Report Wizard window appears. Indicate the desired fields in the report by choosing by highlighting that field and moving it to the selected fields area using the double arrow (>>) buttons located in the center of the screen. Once all desired fields have been selected, click on the Next or Finish button to continue.

![Figure 99: Choose Desired Fields for Report](image-url)
11. Customized Microsoft Access reports will appear with selected field information.

![Figure 100: Customized Microsoft Access Report, page 1](image)

The number of pages for any report will depend on the number of fields selected. Total viewing of the Access report may require use of the Page arrow buttons that appear on the bottom left portion of the screen.

Please refer to the following two images that complete the report as illustrated in the above example.
Figure 101: Customized Microsoft Access Report, page 2

Figure 102: Customized Microsoft Access Report, page 3
Importing the DRM/DRM Plus Extract txt File into Access Database

**Note:** The DRM extract text file was originally saved as an Excel file.

In order to import the DRM extract file (Excel spreadsheet) into a new Microsoft Access database:

1. Open Microsoft Access. In order to do this:
   - Click on Start.
   - Click on Programs.
   - Click on Microsoft Access.

2. Create a new database.

![Figure 103: Import Excel File into Microsoft Access](image-url)
3. Select create a blank database.

Figure 104: Select Blank Database

4. Save your new database.

Figure 105: Save Database
Your screen will look like this.

![Figure 106: Microsoft Access Tables window](image)

You will now begin the process of importing the Excel file that was formally your extract text file. To facilitate this, please go to the top left of the screen:

5. Click on file.
6. Click on Get External Data.
7. Click on Import.
Figure 107: Get External Data

8. Select your Excel file you wish to import. See figure below.

Figure 108: Select Excel File
9. Click Import and the Import Spreadsheet wizard should appear. In the event the wizard is not installed on your machine, please contact your IRM.

![Figure 109: Import Spreadsheet Wizard](image)

10. Select the defaults and click on the Next button to continue.

![Figure 110: Select Defaults for Column Headings](image)
11. Please continue to select the defaults until you reach the following screen:

![Import Spreadsheet Wizard]

**Figure 111: Select Defaults for Storing Data**

12. You have now imported the extract spreadsheet into a Microsoft Access database.

**Note:** Your facility may provide MS Access training.
Reports can be customized by using a variety of Excel functions including deleting, expanding, formatting, sorting, and subtotaling fields. Data may also be copied to other Excel worksheets to create numerous separate reports.

Deleting Columns or Rows

To delete a column or row:

1. Click on the column or row header, this will highlight the column (or row) to be deleted.
2. Click Edit.
3. Click Delete - This same function can be initiated by right-clicking with the cursor in the highlighted area.

Figure 113: Creating Custom Reports in Excel – Deleting Columns or Rows
Expanding Columns or Rows

Put the cursor on the line between the column heading letters. The cursor will turn into a cross with two arrows. Holding the left mouse button down, while the cross is on and dragging right or left, will expand or contract the column or row. A double-click while the cross is on will automatically expand or contract the column or row to fit the contents.

Field Formatting Options

Click the Format menu. The following is displayed.

![Figure 114: Field Formatting Options](image)

Click on Cells. The following box is displayed.

![Figure 115: Format Cells](image)

Select the desired option and enter the desired changes.
Set Horizontal/Vertical settings to make the report easier to read. Setting the text control to wrap text will automatically wrap the text within the space allotted for the cell. The height of the cells in the row or column will change. Click the Alignment tab to display the following screen.

![Format Cells dialog box](image)

**Figure 116: Text Alignment Options**

Click the Wrap text checkbox. Click OK to complete the process.
Creating a Header for a Report

1. Click on the View menu.
2. Click Header and Footer.
3. Click Custom Header or Custom Footer.

Place the cursor within the appropriate section and either type the Header or click on one of the icons to bring in the date, time or to format the text entered (select the text to be formatted before selecting the icon to format text).

Figure 117: Creating a Header for a Report
The screen will appear as shown below.

![Header Formatting Screen](image1.png)

Figure 118: Header Formatting Screen

**Sorting Data**

To sort data:

1. Highlight the fields to be included in the sort.
2. Click on Data.
3. Click on Sort.

![Sorting Data](image2.png)

Figure 119: Sorting Data
The following box is displayed.

![Sort window](image)

**Figure 120: Data Sort Options**

In the Sort window choose the sorting options by clicking the drop down arrow within the three “Sort by” window options.

**Subtotaling Data**

To subtotal data:

1. Highlight the fields to be included in the sub-total. Click on the Data menu.

2. The following screen is displayed.

![Subtotaling Data](image)

**Figure 121: Subtotaling Data**

3. Click Subtotals.
The following screen is displayed.

![Subtotal Options](image)

**Figure 122: Subtotal Options**

**Pull-Down Options**

**At each change in:** – Select item to perform subtotals when change occurs. The example uses CPT code.

**Use function:** – This example is going to count the number of times a provider did a CPT Procedure in the time frame.

**Add subtotal to:** – Location subtotals will appear. In CPT field location on break.
Sample Report by Provider and Total of Each Procedure Performed

<table>
<thead>
<tr>
<th>SSH</th>
<th>PROVIDER</th>
<th>ENCOUNTER DATE</th>
<th>LOCATION</th>
<th>PRIM PCE</th>
<th>TOOTH NUMBER</th>
<th>SURFACES</th>
<th>ADA CODE</th>
<th>QUADRANT</th>
<th>ICD-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>17. Dec. 04</td>
<td>DENTAL</td>
<td>523.4</td>
<td>00150</td>
<td>1</td>
<td>00150</td>
<td>523.9</td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>17. Dec. 04</td>
<td>DENTAL</td>
<td>523.4</td>
<td>00150</td>
<td>1</td>
<td>00150</td>
<td>523.9</td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>17. Dec. 04</td>
<td>DENTAL</td>
<td>523.4</td>
<td>00150</td>
<td>1</td>
<td>00150</td>
<td>523.9</td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8888800011</td>
<td>D.R. PROVIDER ONE</td>
<td>7. Feb. 05</td>
<td>DENTAL</td>
<td>525.1</td>
<td>2</td>
<td>00100</td>
<td>526.1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 123: Sample of History File
Appendix B – Business Use of the DRM Plus Software

As important it is to know how to use the DRM Plus software, it is equally essential to be aware of how to enter codes, fees and other similar DRM business considerations.

Entering DRM Plus business information may be viewed in three different components

- Local policy and practice
- National policy and practice
- National business practice

Adhering to the following guidelines for each is essential and critical to the success of treating our Veterans. Entering valid data can provide important information on the allocation of VA resources on a national and local level, clarify current and future funding issues, and ascertain how to provide even better care to our patients.

Please review this information carefully. If you have any questions, about the use of the software or the accompanying business policies, please contact the local DRM Plus Subject Matter Expert at your site. If that person cannot answer your question, s/he will know whom to contact to find the correct solution.

**Local policy and practice**

The workflow processes addressing the provider's data entries for the following

- Diagnostic Findings
- Observations
- Approval for proposed 'patient Treatment Plans' are to be established by the local dental manager.

**National policy and practice-Coding Guidelines**

All completed procedures on site must be entered into the DES through DRM. This includes the following:

- procedures by staff
- fee-basis onsite
- sharing onsite
- contract onsite
- residents
- without compensation
- students
- hygienists
• For example, if a surgeon goes to the OR and enters the procedure into PCE (Patient Care Encounter) through the surgery package or through an encounter, that procedure must entered into DES through DRM

• Coding guidelines should be followed in an attempt to calibrate providers so when the same encounters are observed at two separate clinics, this will ensure the encounters are coded the same.

National Business Practices – Fee Basis

• Fee basis patient data must be entered through Dental Record Manager (DRM).
• DRM Fee Basis Report should be completed in DRM when each 2570-D is authorized for payment by the signature of the authorizing dentist (or through the equivalent delegated authority).
• This DRM Fee Basis Report will automatically be sent to the Dental Encounter System (DES) database in Austin. Please note that the DRM Fee Basis Report is entered at the time the 2570-D is authorized for payment, not at the time of obligation of funds.
• The data must be entered by someone who has access to the DRM Fee Basis Report screen and to CPRS.
Using your mouse, the Version Notes option is available by clicking on the Help pull-down menu. In order to access this option, the DENTALMRM.INI must contain certain important entries.

**Figure 124: Installing DRM Plus Version Notes**

The Version Notes file from the Help menu in DRM Plus, the file DENTALMRM.INI located in the DOCSTORE folder should contain the following heading and entries:

```
[FTPPARMS]
FTPHOST=ftp.docstorsys.com
FTPPASSWORD=dss376
FTPUSERID=DRM
```

If the FTPHOST parameter is currently set to a specific IP address, then that value should be changed to the one shown above.

**Figure 125: DOCSTORE Folder**
Appendix D – How to Map Dental CNTs

**Important Note:** These procedures will require IRM Assistance. The dental staff should provide these instructions to IRM.

In order to confirm that the CNT's are mapped correctly:

1. Open the `\DOCSTORE\Array\dntarray.txt` file located on the server to confirm that within the "dntarray.txt" file the path for EACH CNT is correct (example of one):

   `\whaservername\DOCSTORE\FORMS\160_DENT\96160001\DENT_HYG.EXE^1`.

![Figure 126: How to Map Dental CNTs](image-url)
2. Open one of the CNT .ini files within the \DOCSTORE\FORMS directory.

(Example):  \vhaservername\DOCSTORE\FORMS\160_DENT\04160001\DRMEval

3. Confirm that the VHAservername path matches what was in the \Array\dntarray.txt file and is correct.

4. If the vhaservername within any of the \FORMS\160_DENT\########\ini_files does not match the directory shown above (in the ARRAY folder), then each .ini file within the FORMS directory would need to be opened and edited with the correct path.